
Address Database Help
The Contents lists Help topics available for Address Database.    Use the scroll bar to see 
entries not currently visible in the Help window.    To learn how to use Help, press F1 or 
choose Using Help from the Help menu.

Address Database Basics:

Introduction
How to use Address Database

Menu Commands:

File Menu
Edit Menu
Labels Menu
Reports Menu
View Menu
Tools Menu
Help Menu



Introduction

Address Database is a extremely powerful electronic name and address book.    Since it 
is a Windows program, it is simple to use.    

Features of Address Database
Address Database Enhancements
Hardware Required
Installing Address Database
Upgrading to Address Database 3.0
How to purchase a copy of Address Database



How to use Address Database

The main screen for Address Database contains a Summary List which gives you a 
preview of the names and phone numbers in Address Database.      Each time you click 
on a name in the Summary List, the detailed information is displayed on the bottom 
half of the screen.      The total number of names is displayed along with the total 
number of names that have been deleted but not purged.

Opening a File
Find a Name
Apply Changes to an Existing Record
Adding Names
Deleting Names
Adding Notes to a Name
Creating a Holiday List
Intelligent Zip Code
Intelligent Phone Numbers
Intelligent Capitalization
Dialing a Phone Number
Shortcuts (CTRL + Letter)



File Menu

The File Menu in Address Database allows you to create new files, open existing files, 
import a file, export a file, merge two files together, and exit Address Database.

New (Create a new file)
Open (Open an existing file)
Save As (Save the file as a new name)
Import (Importing a file into Address Database)
Export (Exporting a file for other applications)
Merge (Merging two files together)
Exit (Exit Address Database)



Edit Menu

The Edit Menu in Address Database allows you to copy a field, copy all information 
(name, address, etc.), paste a copied field, find a particular name, undelete a 
previously deleted name, purge the deleted names.

Copy Field (Copy information to Clipboard)
Copy All Information (Copy Name/Address,Etc.)
Paste (Paste information from Clipboard)
Find (Find a particular name)
Undelete (Recover deleted information)
Purge Deletes (Get Rid of Undeletes)
Purge Deletes on Exit
Preferences



Labels Menu

The Labels Menu in Address Database allows you to specify the type of labels you will 
be using, obtain mailing label instructions, print mailing labels, and print file folder 
labels.

Adjust Label Alignment
Mailing Label Instructions
File Folder Instructions



Reports Menu

The Reports Menu in Address Database allows you to print a phone list, address book, 
and a holiday list of names and addresses.

Print Phone List
Print Address Book
Print Address Book (Compressed)
Print Address Book with Notes
Print Holiday List



View Menu

The View Menu in Address Database allows you to view all names in the currently 
displayed file or filter the display so that only certain records are displayed based on 
selection criteria.

All (View all names in currently opened file)
Filter (View particular names based on selection criteria)



Tools Menu

The Tools Menu in Address Database allows you to display a To Do List, send the author 
suggestions, obtain a list of additional products offered by the author, and purchase 
Address Database (if you are not a registered customer).

To Do List
Other Available Products
Suggestion Box



Help Menu

The Help Menu in Address Database allows you to display this help text and display 
information about Address Database and it's author.

Context Sensitive Help
About Address Database



Features of Address Database

Address Database allows you to:

1. Store up to 819 names and addresses per file.      If you require storing more 
names and addresses than this, Address Database Professional Edition will allow 
an unlimited number of names and addresses.

2. Store and print notes about each person in your address book; If you have 
previously stored notes for a person, the notes button contains asterisks next to it
to alert you of the stored notes

3. Change and delete information in your address book; Quickly find a particular 
person in your address book

4. Undelete (restore) names previously deleted;    once you are sure you will never 
need them, you may purge your undeleted names

5. Maintain a list of people you generally send holiday cards and gifts to;    print a 
report of the holiday list

6. Print a phone list or address book of names in the address book; customize the 
report by choosing the font size, font characteristics,    the number of lines on the 
page,    how many lines to skip between names and the number of lines to skip 
prior to printing the page

7. Print an address book of the names; print them on standard paper or in Day-Timer
Jr. size

8. Print mailing labels of people you choose; print multiple copies
9. Keep a list of your file folders;    print file folder labels
10. Copy a single field and paste it to another field; or copy all information for a 

person and paste it into another application (such as Notepad, Write, Word, etc.)
11. Filter your address book by category (based on their category or any other 

criteria).    You may specify wild cards when filtering on this criteria
12. Keep a "To Do List" to help you get more organized 
13. Import names and address from other applications
14. Export names and address from Address Database to other applications (for mail 

merge, etc.)
15. Merge two files together to create a consolidated address book
16. Contains an intelligent zip code that automatically fills in the city and state for zip 

codes that have previously been entered
17. Contains intelligent phone numbers that automatically converts alphabetic to 

numeric.    For example, it would convert 800-94steve to 800-947-8383
18. Customize the mailing labels to use any type of labels. You simply tell Address 

Database the characteristics of your labels and it handles the rest
19. Automatically dial any of the numbers in your phone book by simply clicking a 

button
20. Send Pragmatic Software suggestions for future releases



Address Database Enhancements

The latest release of Address Database contains the following improvements:

1. Allows you to choose the font name for printing labels and reports.
2. Contains a new report named "Address Book with Notes".    This report prints an 

address book that contains all the notes stored for each person.    You can choose to 
print only those names that have stored notes or all names in your address book.

3. Added ability to sort mailing labels and summary list by either last name or zip 
code.      If you mail over 100 letters, sorting them by zip code will allow you to 
obtain a postage discount.

4. Created 2 user-defined fields on the main screen of Address Database.    You can 
name those fields anything you like and this will appear on Address Database 
screens and reports.

5. Professionally binded User's Guide and Tutorial.    Combined the User's Guide and 
Tutorial for a single reference.

6. You can now choose from a list of valid "States" when entering addresses, or you 
can override this with your own abbreviation.

7. Enhanced graphics which includes the new Address Database logo.    Also includes a
label that states "Custom Designed for <Your Name>" on the main Address 
Database screen.

8. Professionally designed Help screens that use the standard Windows Help facility.
9. Added Preference for storing your name and address.    This information is used 

when printing the suggestion box letter, purchase registration form and the 
"Additional Available Products" letter.

10. Now allows you to change a person's name in your address book rather than forcing
you to delete and then add the new name.

11. Enhanced error trapping.
12. Now allows users to purchase the product by using American Express, Visa, 

MasterCard, Cash, Check, Money Order or Cashiers Check. Also take orders via 
Internet and CompuServe.

13. Once a file is imported, it is automatically opened for use.
14. New interface that sports a fresh 3-Dimensional look.
15. Increased functionality from the main Address Database screen:
16. "Filter" has been added as a button on the screen.    Once you have filtered for 

particular names, the "Filter" button becomes "View All" to allow you to easily turn 
off the filter. 

17. "Dial" buttons have been added to allow you to tell    Address Database to dial the 
number for you.

18. The "Notes" button has been improved to be displayed as "Notes (***)" for each 
name that has notes stored.

19. New EDIT / PREFERENCES menu item that allows you to customize report layouts, 
screen preferences that allow you to specify a default category if one was not 
entered, mailing label preferences that allow you to use any type of labels instead 
of forcing you to use Avery labels, and dialing preferences.

20. You no longer have to specify whether you are using a Laser or Dot Matrix printer.
21. You no longer have to specify "Day Timer Jr." paper to create a report for your Day-

Timer.    Simply set the Report Preferences to determine the layout of the report and 
you may print the report in any format, for any type of binder.

22. Increased flexibility in filtering your information.    Prior to this release, you could 
only filter based on category. You may now filter based on any field stored.    You    
specify wild cards to filter based on specific criteria.    For example, if you would like 
to filter all names that begin with Mil, specify the wild card "Mil*" in the "Last Name"
field of the filter screen.



23. Better file integrity.    For users that work on a network, the file is actually closed 
and reopened each time a record is changed or added.    This prevents loss of data 
due to network crashes. 

24. Allows you to enter non-USA phone numbers so that it may be used in countries 
other than the United States.

25. A new report has been added, called the Address Book (Compressed) report.    This 
is a small-font report that lists all names and addresses in a one-line per record 
format.



Hardware Required

Address Database is designed to work with:

1. IBM 286 or higher compatible computer running Microsoft Windows version 3.0 or 
higher

2. A monochrome or color EGA, VGA, or better monitor
3. A hard disk
4. 1 Megabyte of memory
5. Any type of printer
6. Windows Notepad (installed)



Installing Address Database

To install Address Database, simply run SETUP.EXE from the installation diskette.    This 
automatically creates a program group in Program Manager.    If you would like for Address 
Database to be automatically run each time Windows is started, drag the Address Database 
icon into the "STARTUP" program group.    

To automatically open a specific    file when starting Address Database, set the properties in 
Program Manager to pass Address Database the file name (it automatically opens the last 
file accessed).    For example, to open MYFILE.ADB each time you execute Address Database,
click once on the Address Database icon in Program Manager.    Press ALT + ENTER to set the
properties.    You will see the following screen:



Upgrading to Address Database 3.0

If you have a previous version of Address Database installed and would like to install the 
new version, simply run the SETUP.EXE program.



Purchase a copy of Address Database

There are 3 ways to purchase Address Database:

1. Check, cash, cashiers check or money order - Send $34.99 plus $5 shipping 
and handling ($10 S/H outside of USA) to:

Pragmatic Software Co.
Attn: Steve Miller
6728 Bellehaven Drive
Plano, TX 75023

2. American Express - Call 214-517-2540 (available 24 hours) and leave a message 
stating your name (as it appears on the American Express card), address, phone 
number, American Express card number and expiration date.      Or, mail this 
information to:

Pragmatic Software Co.
Attn: Steve Miller
6728 Bellehaven Drive
Plano, TX 75023

3. Visa or MasterCard - Place your order by calling NorthStar Solutions at 1-800-699-
6395 from 10:00 a.m. to 10:00 p.m., Eastern Standard Time.      NorthStar Solutions 
also accepts registrations via CompuServe (71561,2751) or the Internet 
(71561.2751@compuserve.com). 



Opening a File

To open an existing Address Database file, click FILE / OPEN or press CTRL + O.    It will 
display a list of files.    Click on the file name you wish to open.    Click "OK" to select the file 
or    click the "CANCEL" button to cancel the operation.    

When you initially start Address Database, it automatically remembers the last file you had 
open, and will open that file.

Optionally, you may automatically open a specific file each time Address Database is started
by setting the properties in Program Manager to pass Address Database the file name.    For 
example, to open MYFILE.ADB each time you execute Address Database, click once on the 
Address Database icon in Program Manager.    Press ALT + ENTER to set the properties.    In 
the "Command Line" of the Program Items Property, enter    C:\ADDRDB\ADDRDB.EXE 
MYFILE.ADB.    See "Installing Address Database" for more information.



Finding a Name

To find a name in the Address Database, click EDIT / FIND or press CTRL + F.    The cursor will 
be placed on the "Find this Last Name" field on the screen.    Enter the "last name, first 
name" and press TAB or ENTER.    The Summary List will show the first name that matches 
the name entered.    If no match is found, it displays the name that is greater than the one 
entered.



Applying Changes to an Existing Record

To change information for a person, bring up the person by clicking on the person in the 
Summary List.    Then enter the new information and press the "Change" button.    



Adding New Names

To add a new person, click on the "Clear" button.    This clears all the fields for entry.    Enter 
information about the person, including the phone number if applicable.      Once you enter a 
phone number and press tab, the "Primary" button for that phone number is turned on.    
This tells Address Database to use this phone number in the summary list above.    You may 
change this by clicking the primary button for another phone number.    Once done, press the
"Add" button.



Deleting Names

To delete an existing person,    bring up the person by clicking on the person in the Summary
List.    Then click the "Delete" button.    It will ask you if you really want to delete this person.  
Press "Yes" to delete and "No" to cancel.    



Adding Notes to a Name

To add notes for a person, bring up the person by clicking on the person in the Summary 
List.      Then click the "Notes" button.    Enter notes in the Notepad and exit when done.    
Each time you press "Notes" for this person, the notes that were stored will appear.    Notice 
that if no notes are stored for the person, the button displays "Notes".    If there are notes 
stored, the button displays "Notes (***)".    This is done to alert you as to the people you 
have notes stored.

Note: You may print an Address Book that contains the notes of each person you have 
stored.    To do this, simply select "REPORTS / PRINT ADDRESS BOOK WITH NOTES" from the 
menu.



Creating a Holiday List

To have a person appear on the Holiday List report, bring up the person by clicking on the 
person in the Summary List.    Then click the "Holiday List" checkbox.    Click "Change" to 
save the changes. 

Note: You may print the Holiday List. To do this, simply select "REPORTS / PRINT HOLIDAY 
LIST" from the menu.



Intelligent Zip Code

Address Database contains an "Intelligent Zip Code" which automatically enters the city and 
state if the zip code is the same as any others in the database.    Because of this, you will 
notice that the cursor appears in the zip code field prior to going to the city field.



Intelligent Phone Numbers

Address Database contains "Intelligent Phone Numbers" which automatically reformats the 
phone number you enter to the format 111-111-1111 x1111.    It will also convert alphabetic 
to numeric (i.e. 800-94PHONE is converted to 800-947-4663).      

Note: If you have the "Allow Non-USA Phone Numbers" checked on the EDIT/PREFERENCES 
screen, it will bypass this edit.



Intelligent Capitalization

Address Database contains "Intelligent Capitalization" which automatically capitalizes the 
first character of each line.    For example, if you enter a last name of miller and a city of 
plano, it will change them to Miller and Plano.



Dialing a Phone Number

You can have Address Database dial a phone number for you by simply clicking the "Dial" 
button next to the phone number in the Detailed Information section of the screen.    Once 
this is clicked, it will display the number it is dialing.    Simply pick up the phone and press 
the "OK" button.

Notice that Address Database will prefix the phone number if a prefix is specified in the EDIT
/ PREFERENCES screen.    Also, Address Database automatically prefixes phone numbers that
contain an area code with a '1'.



Shortcuts (CTRL + Letter)

Address Database allows you to use the following keys as shortcuts.    By pressing these 
keys, the function is automatically executed.    (CTRL + LETTER means to hold down the 
CTRL key and press the letter.)

1. File New CTRL + N
2. File Open CTRL + O
3. File Save As CTRL + S
4. Copy Field CTRL + C
5. Paste CTRL + V
6. Find Name CTRL + F
7. Undelete CTRL + U
8. Print Mailing Labels CTRL + M
9. View All Names CTRL + A
10. Filter Names CTRL + I
11. To Do List CTRL + T
12. Help F1



New (Create a new file)

To create a new Address Database file, click FILE / NEW or press CTRL + N.    It will prompt 
you for a file name.    Enter the name of a file that is not currently being used.    The 
extension of the file name must be ".ADB" (i.e. NEWFILE.ADB).    Press "OK" to create a new 
file or click the "CANCEL" button to cancel the operation.    



Open (Open an existing file)

To open an existing Address Database file, click FILE / OPEN or press CTRL + O.    It will 
display a list of files.    Click on the file name you wish to open.    Click "OK" to select the file 
or    click the "CANCEL" button to cancel the operation.    

To automatically open a file when starting Address Database, set the properties in Program 
Manager to pass Address Database the file name.    For example, to open MYFILE.ADB each 
time you execute Address Database, click once on the Address Database icon in Program 
Manager.    Press ALT + ENTER to set the properties.    In the "Command Line" of the Program 
Items Property, enter    C:\ADDRDB\ADDRDB.EXE MYFILE.ADB.    See "Installing Address 
Database" for more information.



Save As (Save the file as a new name)

To save the currently opened file as a new name, click FILE / SAVE AS or press CTRL + S.      
Notice that only the records currently in the Summary List are saved.    This allows you to 
"Filter" the list saving only the filtered names as the new file.      Of course, you may do a    
VIEW / ALL and a FILE / SAVE AS to save all names in the file to a new name.



Import (Importing a file into Address Database)

To import a file into    Address Database, click FILE / IMPORT.      A screen will be displayed that
allows you to let Address Database know the layout of the import file.    This screen also has 
a list of instructions at the top of the screen.    To cancel the import, click the "CANCEL" 
button.

To import a file you must do the following:

1. Create the import file in comma-delimited format.    Make sure that the file resides 
in the same directory as Address Database.    

2. Enter the "Import File Name" and "File Name to Create".    The "File Name to Create"
should have an extension of ".ADB" (i.e. NEWFILE.ADB).    

3. Choose the fields that appear on the Import file in the order in which they appear 
on the file.    Do this by clicking each field name in the order as it appears on the 
file.    Once you click it, you will see it move to the box on the right.    If a field name 
is on the Import file but not in the list, click on the <<UNDEFINED>> field name.

4. If you make a mistake,    click the "RESET" button.
5. Click the "IMPORT NOW" button to begin the Import.    Once imported, a record 

count will be displayed and the imported file will be automatically opened. 



Export (Exporting a file for other applications)

To export a file from Address Database, click FILE / EXPORT.    It will prompt you for a file 
name.    Enter the name of a file that is not currently being used.    Press "OK" to create a new
file or press the "CANCEL" button to cancel the operation.    



Merge (Merging two files together)

To merge 2 files together in Address Database, open the file that will contain the names after
the merge.    Then click on FILE / MERGE.    It will display a message telling you that a backup 
of the original file will be created and named "*.BAK", where * is your original filename.    
Press "OK".



Exit (Exit Address Database)

To exit Address Database, click FILE / EXIT.



Copy Field (Copy information to Clipboard)

To copy a field on the screen, put the cursor on the field and click EDIT / COPY FIELD or press
CTRL + C.    The contents of the field will be copied and placed into the Windows Clipboard.    
You can now paste this information into any Windows application.



Copy all Information (Copy Name/Address,Etc.)

To copy the name, address and phone number of the name currently displayed, click EDIT / 
COPY ALL INFORMATION.    The information will be copied and placed into the Windows 
Clipboard.    The copied text is formatted so that it can be pasted into a word-processor or 
text-editor.    Below is an example:

Bruce Lee
HardFoot, Inc.
999 Roundhouse Street
Plano, TX    75023
214-144-9864 (Home)



Paste (Paste information from Clipboard)

To paste a copied piece of information, put the cursor on the receiving field and click EDIT / 
PASTE or press CTRL + V.    The contents of the field will be pasted into the field.

To find a name in the Address Database, click EDIT / FIND or press CTRL + F.    The cursor will 
be placed on the "Find this Last Name" field on the screen.    Enter the "last name, first 
name" and press TAB or ENTER.    The Summary List will show the first name that matches 
the name entered.    If no match is found, it displays the name that is greater than the one 
entered.



Find (Find a particular name)

To find a name in the Address Database, click    "EDIT / FIND" or press CTRL + F.    The 
cursor will be placed on the    "Find this name" field on the screen.    Enter the "last name, 
first name" and press    or .    The Summary List will show the first name that matches the 
name entered.    If no match is found, it displays the name that is greater than the one 
entered.



Undelete (Recover deleted information)

To undelete a previously deleted name in the Address Database, click EDIT / UNDELETE or 
press CTRL + U.      It will display all names that are available to be undeleted.    Double Click 
the name to undelete.    

Once double clicked, <<UNDELETE>> appears next to the record.    Double click again to 
turn off <<UNDELETE>>.      To turn off all <<UNDELETE>>, press the "RESET" button.    To 
undelete the items marked <<UNDELETE>>, click the "UNDELETE AND EXIT" button.      Click
on "CANCEL" to cancel the operation without undeleting any names.



Purge Deletes (Get rid of Undeletes)

To purge the deleted names in the Address Database, click EDIT / PURGE DELETES.      It will 
physically delete from the file all records marked as deletes.    Notice that the new "Delete 
Count" is zero.    Once this is done, an Undelete can no longer be done on those names that 
were purged.



Purge Deletes on Exit

To purge the deleted names in the Address Database every time you open a new file or exit 
Address Database, click EDIT / PURGE DELETES ON EXIT.      It will physically delete from the 
file all records marked as deletes each time you open each new file or you exit Address 
Database.    



Preferences

To specify report, screen and mailing label preferences, click EDIT / PREFERENCES.      

Below are the options available:

1. Report Preferences - Enter the following preferences:
A. Font...: Click on the button to choose a valid font name.    Once a font is 

chosen, the name automatically appears next to the Font button.
B. Font Size in points: Specifies how large to make the font that is printed on the

reports.    The larger the number, the larger the print.
C. Left Margin Tab: Specifies where to tab prior to printing    the report 

information.    Increase this value if you wish to move the printed output to the 
right.    This is useful when    you are putting your printed report in a binder as to 
allow for the binder holes.

D. Blank Lines at Top: Tells Address Database to skip this many lines prior to 
printing the report on the page.    This can be useful when printing reports on 
Day-Timer or smaller than normal paper.

E. Page Break on Line:    Tells Address Database to begin printing a new page 
once the number of lines entered here has been surpassed.

F. Italics Font: Prints the reports in italics print.
G. Bold Font: Prints the reports in bold print.
H. Page Break on New Alphabet:    Specifies that when a new alphabet is 

reached when printing the reports, go to the next page.    This is useful when 
printing an address book that is inserted into a binder that has tabs by 
alphabet.    For example, Day-Timers has the telephone book separated by 
alphabetic tabs.    If you click this, it will create each alphabet on separate 
pages.

I. Skip a Line Between each Name: Specifies that each time a name/address is
printed on the report, skip a line before printing the next name/address (double 
space).

J. Final note:    If you change the font size, the other preferences may need to 
change.    For example, if you change the font size from 8 points to 15 points, 
you may need to tell Address Database to create a page break on line 35 rather 
than 55.      

2. Sort Preference - Choose the appropriate sort sequence:
A. Last Name:    Click this value if you would like to sort the Summary List and 

mailing labels by person's Last Name.
B. Zip Code, Last Name:    Click this value if you would like to sort the Summary 

List and mailing labels by person's Zip Code and then Last Name.    This is 
especially useful when printing a large number of names for postal rate savings. 
If you send over 100 letters and they are sorted by zip code, the cost of mailing 
the letters is reduced.

3. Dialing Preferences - Click on the appropriate communications port and enter a 
prefix number to be used when dialing a phone number.    In other words, a prefix of 
"9" will use 9 as a prefix prior to dialing the number.      Notice that if the phone 
number begins with an area code, Address Database will automatically dial a '1' first.

4. Screen Preferences - Enter the following preferences:
A. Default Category: Enter a default category which will be used any time the 

category field is left blank when adding new names to your address book.



B. User Defined Field 1 Name: This allows you to define a field on the main 
screen to mean anything you like.    To use this, simply type in the name of the 
field followed by a colon.    When the main Address Database screen appears, 
this name will be displayed on the screen.    Additionally, this name will appear 
on all reports.

C. User Defined Field 2    Name: This allows you to define another field on the 
main screen to mean anything you like.    To use this, simply type in the name of 
the field followed by a colon.    When the main Address Database screen 
appears, this name will be displayed on the screen.    Additionally, this name will
appear on all reports.

D. Spaces as Summary List Divider:    Check this box if you do not want to see 
the double arrows dividing the name and the primary phone number on the 
"Summary List" of the main screen.

E. Allow Non-USA Phone Numbers: Check this box if you enter non-USA phone 
numbers.    If checked, it bypasses all edits on the phone number.

5. Mailing Label Setup -    See "Adjust Label Alignment" topic under the Labels Menu 
Section of this User's Guide.

6. Your Name and Address -    Enter your name and address.    This is used by Address
Database to display your name on the main Address Database screen under "Custom 
Designed for (your name)".    It uses the address to create the suggestion box, 
purchase and additional products letters.



Adjust Label Alignment

To tell Address Database what type of labels you are using click on LABELS / ADJUST LABEL 
ALIGNMENT.    

From here, follow the instruction listed on the screen:

1. Choose the font characteristics for the labels.    Specify the font size in points (the 
bigger the number the larger the print), whether to print in italics and / or bold 
print.

2. Print the alignment guide on the label paper you will be using.      The alignment 
guide should be printed only after you have specified the font characteristics.    
Once this done, press the "Print Alignment Guide" button.      Once the Alignment 
guide has been printed, use the guide to answer the remaining questions on the 
screen.

3. How many Labels are across the page (1 - 3)?      Enter the number of labels that 
appear horizontally across the page.    For example:

1 Label Across 2 Labels Across 3 Labels Across
n nn nnn
n nn nnn
n nn nnn
n nn nnn
n nn nnn

4. Based on the alignment guide, enter the tab stops for each column of labels.      Look
at the Alignment Guide that was printed on the label sheet.    Find the "Tab=" that is 
printed in the first column of labels.    This is the number you must tell Address 
Database to tab prior to printing that column of labels.    Do the same for the second
and third columns.

5. How many rows of labels are down the page (1 - 20)?      Enter the number of rows of
labels that appear vertically down the page.    For example:

7 Rows  5 Rows 10 Rows
Row 1: nnn nnn nnn
Row 2: nnn nnn nnn
Row 3: nnn nnn nnn
Row 4: nnn nnn nnn
Row 5: nnn nnn nnn
Row 6: nnn nnn
Row 7: nnn nnn
Row 8: nnn
Row 9: nnn
Row 10: nnn

6. Based on the Alignment Guide, enter the line each row of    labels should begin.      
Look at the line numbers printed on the left side of the Alignment Guide.    Each 
number represents the line number.      If the first line number that is printed on the 
first row of labels is line 3, enter "3" in the "Row 1" field.    If the first line number 



that is printed on the second row of labels is 9, enter "9" in the "Row 2" field.    
Continue to do this for each row of labels.

Notice that Address Database will only allow you to enter information into the 
number of fields specified in item (5) above.

Once all of the information above is entered, press "OK" to store this information.    
If you have made mistakes, press the "Cancel" button.



Mailing Label Instructions

To see instructions for creating mailing labels, click LABELS / MAILING LABEL INSTRUCTIONS.

This describes how to print mailing labels:

1. Print the alignment guide to determine the parameters to enter in the "Adjust Label
Alignment" screen.    See the related topic for details.

2. Put address label paper in printer.
3. Filter the list so that it displays only the names you wish to create labels for.    Hint: 

Use VIEW / FILTER or press CTRL + I.    To print a single label multiple times, VIEW / 
FILTER the label to print, and enter the total number of labels on the page to print a 
full page of labels for this name.

4. Use the LABELS / PRINT MAILING LABELS command, or press CTRL + M, to begin 
printing.    





File Folder Instructions

This describes how to print file folder labels.    Notice that when these are printed, up to four 
fields are printed on the file folder label (last name, first name, address1 and address2).    To 
print file folders:

1. Print the alignment guide to determine the parameters to enter in the "Adjust Label
Alignment" screen.    See the related topic for details.

2. Put address label paper in printer.
3. Filter the list so that it displays only the names with a category of FILEFOLDER.    

Hint: Use VIEW / FILTER or press CTRL + I.    More simply, click "Yes" at the prompt 
and it will automatically filter them for you.

4. Use the LABELS / PRINT MAILING LABELS command, or press CTRL + M, to begin 
printing.    



Print Phone List

Click on this to create a phone list of all names currently displayed.    Notice that you can 
print a phone list of selected names by first "Filtering" the list and then printing this report. 
Once done, the total number of names printed is displayed.



Print Address Book

Click on this to create an address book of all names currently displayed.    Notice that you 
can print an address book of selected names by first "Filtering" the list and then printing 
this report.    Once done, the total number of names printed is displayed.



Print Address Book (Compressed)

Click on this to create an address book of all names currently displayed.    Notice that you 
can print an address book of selected names by first "Filtering" the list and then printing 
this report.    Once done, the total number of names printed is displayed.    The only 
difference between this report and the Address Book report is that this report has 
compressed font which allows you to print a single line per name/address.



Print Address Book with Notes

Click on this to create an address book of all names currently displayed, followed by all the 
notes stored for each name.    When this report is run, it asks you if you would like to 
include only the names that have stored notes or if you would like to include all names.    
Notice that you can print an address book of selected names by first "Filtering" the list and 
then printing this report.    Once done, the total number of names printed is displayed.    



Print Holiday List

Click on this to create an address book of all names that have the Holiday List field clicked.    

To have a person appear on the Holiday List report, bring up the person by clicking on the 
person's name in the Summary List.    Then click the "Holiday List" checkbox.    Click 
"Change" to save the changes. 



All (View all names in currently opened file)

Click on this to take off all filters.    This will display all names in the opened file.



Filter (View particular names based on selection criteria)

To display only the names that meet specific rules, click VIEW / FILTER or press CTRL + I or 
press the "Filter" button from the main screen.      When clicked, it displays a screen that 
allows you to enter the information to filter by.    Additionally, it allows you to choose the 
categories to include in the display.      To cancel, click the CANCEL button.

Notice that the screen has detailed instructions on filtering:

1. First enter the selection criteria for each field.    You may use wild cards.    Below are 
some examples of wild card patterns you may enter:

Kind of matching Pattern Returns
Multiple characters a*a "aa", "aba", "abbba"
Special characters a[*]a "a*a"
Multiple characters ab* "abcdefg", "abc"
Single character a?a "aaa", "a3a", "aba"
Single digit a#a "a1a", "a2a", "a3a"
Range of characters [a-z] "a", "b", "c"
Outside a range [!a-z] "1", "2", "3" (! = not)
Not a digit [!0-9] "a", "b", "&"
Combined a[!b-m]# "an9", "az1", "a99"

2. Choose the categories that appear in the AVAILABLE CATEGORIES box.    Once you 
click a category, you will see it move to the box on the right.    This means that this 
category will be included.

3. If you make a mistake, click the RESET button.

4. Click the FILTER NOW button to filter based on the categories selected.



To Do List

To open a To Do List, click "TOOLS / TO DO LIST" or press CTRL + T.      When clicked, it 
prompts you for a To Do List file name.    If one is not found, a sample one is created, named 
SAMPLE.TOD.    

Use this To Do List each day to record the things you must do each day, in the future, and to 
record things that have been done.    At the end of each day, you may want to save the file 
as something that you can remember, such as the date.    For example, you may want to 
save it as ME010195.TOD which says it is for "ME", for the date of "010195".      

Make sure you save it with an extension of ".TOD" to let Address Database know that it is a 
To Do List.    The To Do List uses the Windows Notepad and may be printed.



Other Available Products

To obtain a list of other products available from Pragmatic Software Co., click TOOLS / OTHER
AVAILABLE PRODUCTS...      When clicked, it creates a letter in Notepad named REGISTER.TXT.



Suggestion Box

To send me a suggestion or to register a problem, click TOOLS / SUGGESTION BOX.      When 
clicked, it creates a letter in Notepad named SUGGEST.TXT.    

Enter your suggestions for new releases.    You may also use this to identify problems you 
find with Address Database.    Print the letter and send it to the address listed.    Letters will 
be given prompt attention.



Context Sensitive Help

Press    to receive help on any topic.    It is context sensitive which means that when F1 is 
pressed, the appropriate help topic is displayed based on where you are positioned on the 
screen.    For example,    if you would like help learning how to change a record, place the 
cursor on the Change button and press F1.



About Address Database

Click HELP / ABOUT ADDRESS DATABASE to display the name of the software, the version, 
copyright information, address for purchasing and the purchase price.




